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Using Authority Control
 

This document describes:
•     The importance of Authority Control
•     How to implement Authority Control in your library
•     How to maintain Authority Control
•     How to implement “See” and “See also” cross-references
•     How to use the Quick Editor to create authority records
•     Additional M3 Authority Control features
 
A glossary of Authority Control terms is included at the end of this document.
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Overview
 
Authority Control is essential for truly effective searching of your collection. It is a system that maintains
consistency  in terms when cataloging names, subjects, and uniform titles/series in your collection. It also
provides interconnecting links among these headings (also known as See and See also references).
 
By selecting one consistent standard for your headings, your patrons can find all works on a specific topic
with one single search. They can also find related works with the same search. For catalogers, Authority
Control provides a standard to follow when cataloging authors, subjects, and uniform titles/series.
 
For example, how would you catalog the subject (MARC field 650 – Topical Term) for a book titled The
History of the Porsche? Would you enter Cars or Automobiles? Although both subjects sound correct, there
is only one correct subject heading for this title, according  to the Library of Congress. The correct subject is
known as the “established heading” or the “authorized heading.”
 
In the example above, Automobiles is the correct subject heading. This is the heading that needs to be
in your subject field (MARC field 650 – Topical Term) when cataloging this title. Cars is considered the
“unestablished heading” or “unauthorized heading.”  It is not the correct heading for your subject field.
 
However, there is the possibility that patrons will enter Cars when searching for this book in your OPAC.
Without Authority Control, they would not find this book, since your cataloger entered Automobiles as the
subject. With Authority Control, your patrons would be directed to the book with a See Automobiles cross-
reference.
 
Using Cross-References
In Authority Control, there are two types of cross-references:  See and See also.

•     A See reference  is a link from an unestablished heading to the established heading; the patron
is being directed to the correct subject.
•     A See also reference is a link from an established heading to other related established headings.
In the Automobiles example, a patron might see the cross-reference  See also Transportation if you
have other titles in your collection concerning this subject.

 
Bibliographic Fields under Authority Control
Not all fields in a bibliographic record are governed by Authority Control rules. Those fields that are not open
to subjective interpretation are not under Authority Control. For example, there is only one way to catalog
the title of a book (MARC field 245 – Title) but multiple ways to catalog an author’s name (MARC field 100 –
Personal Name).
 
The bibliographic  fields under Authority Control are those fields that could be cataloged in a variety of ways
— any fields involving names, subjects, and uniform titles/series. Table 1 lists the bibliographic  fields under
Authority Control.
 
TABLE 1
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Linking Bibliographic Fields to  Established Headings
For bibliographic fields to be under Authority Control, a link must be created between the bibliographic  field
and the correct Authority Control definition for that field (that is, the established heading). In M3, this link is
performed by the authority table.
 
The authority table is where authority records are stored. Authority records are very similar to bibliographic
records; they also contain fields and subfields. For every bibliographic  field under Authority Control, there is
a corresponding authority record containing the established heading for that field. The established heading
is in a specific field within the authority record.
 
In M3, the bibliographic  fields under Authority Control are linked to their appr priate authority records
through a process called verification. This process is described in “Step 4: Verify Your Bibliographic
Records” and can be performed at any time.
 
Table 2 lists the authority fields within an authority record that are used for established headings, along with
the corresponding  bibliographic fields. The bibliographic fields link to these fields in an authority record to
obtain the established heading.
 
TABLE 2
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Implementing Authority Control
 
Implementing M3 Authority Control in your library requires six steps. Once com- pleted, your library will have
a fully functioning Authority Control system for both your catalogers and patrons.
 
Step 1: Determine Subject Scheme
Every subject field in a bibliographic record (that is, MARC fields 600 – Personal Name Subject, 610 –
Corporate Name Subject, 611 – Meeting Name Subject, 630 – Uniform Title Subject, 650 – Topical Term,
and 651 – Geographic Name Subject) is governed by a subject scheme. The most common subject scheme
is Library of Congress (LC), but your library may use one of the following schemes:
 

•    LC subject headings for children’s literature
•    Medical subject headings
•    National Agricultural Library subject authority file
•    Canadian subject headings
•    Art and architecture  thesaurus
•    Sears
•    Répertoire de vedettes-matière

 
To determine which subject scheme your library uses, you need to review all bib- liographic records with 6xx
subject fields. The second indicator in each 6xx sub- ject field determines the subject scheme.
 
M3 Authority Control supports the LC subject scheme by default. However, if you want to use a different
scheme, M3 Technical Support can change the default sub- ject scheme for you. M3 Authority Control
supports all the subject schemes listed above, including Sears.
 
M3 Authority Control currently supports only one subject scheme at a time. For this reason, it is preferable
to have bibliographic records with the same subject scheme. If you have bibliographic records with a variety
of subject schemes, only those bibliographic fields that correspond to your chosen subject scheme will link
to your authority table.
 
Step 2: Audit Your Bibliographic Records
Auditing the bibliographic  fields under Authority Control is a critical step. The condition of these
bibliographic fields affects the quality of your authority table. When auditing your bibliographic records, there
are three areas to pay close attention to:
 

•     Consistency – Especially in an older collection, your bibliographic records may have variations
of the same name, subject, or uniform title/series due to different catalogers. For example, your
collection may have titles on Winston Churchill cataloged as Winston Churchill; Winston Churchill,
1874-1965; Sir Winston Churchill; and Sir Winston Churchill, 1874- 1965. It is important that these
inconsistencies  be corrected by changing them to the correct heading.
 
•     Completeness – Your bibliographic records need to be complete. For example, a title by Ernest
Hemingway that is cataloged as Ernest  Hem- ingway in MARC field 100 – Personal Name is
incomplete. The complete form of the name is Ernest  Hemingway, 1899-1961.
 
•     Misspellings – Misspellings and typos need to be corrected. These affect the linking between
your bibliographic  fields and their associated authority records because an exact match between
the two records will not be made.
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You must determine whether your bibliographic  records have the headings required to create the authority
table. If your database does not contain full MARC records, Mandarin may recommend  that you first do a
brief record upgrade. Man- darin can act as a consultant to assist in determining whether your records meet
the matching criteria required to set up your authority table.
 
Auditing your records is important for the verification process explained in “Step 4: Verify Your Bibliographic
Records.” During the verification process, an exact match must be found between your bibliographic fields
and the authority records. If your bibliographic fields are missing subfields or have misspellings, an exact
match cannot be made and a link between the two records is not created.
 
Step 3: Create Your Authority Table
There are four ways to create your authority table.
 
Importing Authority Records
You can import your authority records from a vendor or any other source.
 
Mandarin offers an Authority Processing Service that provides a full authority record with cross-references
  for each heading. This service also updates your col- lection with the most current Library of Congress
subject and name headings. The end result is a complete authority file tailored for your library and ready for
import into your M3 system.
 
The subject scheme of your authority records and your bibliographic  records must match. To verify which
subject scheme your authority records are using, open an authority record and double-click MARC field 008.
The subject scheme is reflected in position 11 of this field.
 
Subscribing to the Library  of Congress Database
Every bibliographic  field under Authority Control in your collection is compared to the Library of Congress
database. The established headings and cross-references are then directly downloaded to your authority
table, greatly reducing the possibility of errors.
 
This Library of Congress database, which is hosted by Mandarin, contains over
5 million established headings and cross-references.  It is the most comprehensive and accurate source
for authority records. It is constantly being updated and all updates are available for immediate download.
Please note that in order to sub- scribe to the Library of Congress database, you must use the Library of
Congress subject scheme.
 
Using the M3 Authority Table
The M3 Authority Control module includes a 50,000-record authority table that uses the Library of Congress
subject scheme. Using this table is similar to com- paring your records to the Library of Congress database;
however, you are pro- vided with 50,000 records instead of 5 million, and updates are not provided.
 
Creating Your Own Authority Records
This is time-consuming and subject to human error. However, it may be beneficial if you want to quickly
create a small number of authority records. Once again, you must make sure the subject scheme of your
authority records matches the subject scheme of your bibliographic records. You should also enter your
library name in MARC field 040 – Original Cataloging Agency to indicate that the authority records were
created internally.
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Step 4: Verify Your Bibliographic Records
In M3, this is the process that links every bibliographic  field under Authority Con- trol to the appropriate
authority record. This process is performed in the Cata- loging module.
 
After you have set up your authority table, perform a search for all your biblio- graphic records in Cataloging.
Then, on the Edit menu, select Bibliographic, select Update Authority Control, and then click one of the
following three options:
 

•     Verify All – This links all your bibliographic  fields under Authority Control to the appropriate
authority record. Depending on the size of your collec- tion, this process may take a while. It should
only be performed once when you initially set up Authority Control. If you select Verify All on a
collection that has already been verified, the process unlinks the already verified records before
re-linking them. This is an unnecessary and time-con- suming process, so this selection should be
used with caution.
 
•     Verify New – This links any new, unverified bibliographic  field to the appro- priate authority
record. This is usually performed  if Authority Control is already set up in your library and you import
or create new bibliographic records.
 
•     Unlink Bibliographic – This reverses the verification process, so it should be used with caution.
When selected, it unlinks all bibliographic fields from their appropriate authority records. This
action cannot be undone once selected. When the unlinking is complete, you can only re-link your
bibliographic records to the authority table by selecting  Verify All.
 

Once your verification is complete,  all bibliographic fields under Authority Control are linked to their
appropriate authority records. You can verify this by opening your bibliographic records; any field under
authority control displays an @ sub- field followed by the ten-digit control number of the associated authority
record.
 
It is important to remember that a bibliographic record is usually linked to mul- tiple authority records. If a
bibliographic record has multiple fields under Authority Control, each of those fields is linked to a separate
authority record.
 
Conversely, an authority record is usually linked to multiple bibliographic records; therefore, multiple
bibliographic records will use the same authority record. For example, all your titles by John Steinbeck will
link to the John Steinbeck authority record.
 
 
If you want to review the authority record for a particular bibliographic field, you can search the authority
table for the control number in the @ subfield. To per- form this search in the Cataloging module:
 
1.      On the Edit menu, click Search. This displays the Search dialog box.
2.      In the Search For list, select Authority.
3.      In the keyword box below the Anywhere field, type the ten-digit control number, and then click
Search. The upper pane of the Cataloging window dis- plays the authority record associated with that
bibliographic  field; the lower pane displays all bibliographic  records linked to that authority record.
 
An example of an authority record with its associated bibliographic records is shown in Figure 1.
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FIGURE  1

 
Step 5: Check Your Authority Verification Log
Any bibliographic  record that has had ALL fields verified displays a MARC field
950 – Authority Control Flag. This field consists of an @ subfield with the numeric value of “1”. If a
bibliographic record has MARC field 950, it indicates that all its bibliographic  fields are linked to the
associated authority records and no further verification is needed. There is only one MARC field 950 per
bibliographic record.
 
If a bibliographic record does not have a MARC field 950, review the record to determine why the
verification was unsuccessful.  In most cases, this is due to the subject scheme of the bibliographic field not
matching the default subject scheme.
 
This can be verified by checking the Authority Verification log. This log resides in the AuthorityLogs folder
located in your M3 directory (by default, C:\Program Files\Mandarin M3). The Authority Verification log lists
by ISN number all bibliographic subject fields that were not compatible with the default subject scheme.
 
Note: All authority records have a MARC field 040 – Orig- inal Cataloging Agency. If you subscribe  to the Library of Congress
database, your authority records have the symbol “DLC” in this field. If you import your authority records from a vendor, your
authority records have the symbol of the cataloging agency in this field. If you have created your own authority  records, you
should have indicated this  in MARC field 040 (see “Creating Your Own Authority  Records”).
 
You can then search your bibliographic table for the ISN number to review the bib- liographic field. To
perform this search in the Cataloging module:
 
1.      On the Edit menu, click Search. This displays the Search dialog box.
 
2.      In the Search For list, select Bibliographic.
 
3.      In the first record field list, type 001 over the default field name.
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4.      In the keyword box below, type the ISN number,  and then click Search. This displays the bibliographic
record with this ISN in the upper pane.
 
Step 6: Check Your Skeletal Authority Records
The verification process compares your bibliographic fields with the authority records in your authority table.
For a link to be established, a perfect match must be found. For example, if your bibliographic  field contains
the entry Mark Twainn  instead of Mark Twain, a link between this bibliographic  field and the Mark Twain
authority record will not be created. Instead, a skeletal authority record is created for this bibliographic  field.
 
Skeletal authority records are created when an exact match is not found between a bibliographic  field and
an authority record during the verification process. This is often due to a misspelling in the bibliographic 
field, and can easily be corrected. Because skeletal authority records have no entry in MARC field 040 –
Original Cataloging Agency, you can search your authority table for all skeletal records and review them for
accuracy. To perform this search in the Cataloging module:
 
1.      On the Edit menu, click Search. This displays the Search dialog box.
 
2.      In the Search For list, select Authority.
 
3.      In the keyword box below the Anywhere field, type an asterisk (*).
 
4.      In the first Boolean operator list, select NOT.
 
5.      In the record field list next to NOT, type 040* over the default field name.
 
6.      Click Search. This displays all skeletal authority records in the upper pane of the window. The
associated bibliographic records display in the lower pane.
 
Review the associated bibliographic records listed in the lower pane to confirm whether the skeletal record
was created correctly or due to an error in the biblio- graphic field. If the skeletal record was created due to
an error or a mismatch, you can correct the bibliographic record and then reverify it. The bibliographic field
is then linked to the appropriate authority record, and the skeletal record can be deleted and purged.
 
It is important  to remember that a skeletal authority record  could be correct. If you do not have an authority
record for the bibliographic field you are verifying, then the corresponding authority record is created when
verification is complete. If you subscribe to the Library of Congress database, this should not happen.
However, if you create or import your own authority records, you may be missing an authority record for
a bibliographic record in your collection. The verification process creates that authority record for you;
however, the skeletal authority record should be checked for accuracy and completeness.
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Maintaining Authority Control
 
Once the six steps for setting up Authority Control are complete, maintenance is simple. You should perform
the following four steps on a regular basis.
 
Step 1: Verify New Bibliographic Records
Whenever you import or create new bibliographic records, they need to be verified. There are two ways to
verify records in the Cataloging module:
 

•     In the Cataloging window, select all of the new or imported bibliographic records. Right-click in
the pane containing the bibliographic records, then click Verify Selected  Records on the command
menu.
 
•     On the Edit menu, select Bibliographic, select Update Authority Control, and then click
Verify New. This verifies all unverified bibliographic records (that is, those bibliographic records
without a MARC field 950 – Authority Control Flag).

 
Step 2: Search for  Unverified Bibliographic Records
You should periodically search your bibliographic table for unverified records. Unverified bibliographic
records are missing MARC field 950 – Authority Control Flag. A missing MARC field 950 indicates that the
record was never verified and its bibliographic  fields are not linked to any authority records. To perform this
search in the Cataloging module:
 
1.      On the Edit menu, click Search. This displays the Search dialog box.
 
2.      In the Search For list, select Bibliographic.
 
3.      In the first record field list, type 001 over the default field name.
 
4.      In the keyword box below, type an asterisk (*).
 
5.      In the first Boolean operator list, select NOT.
 
6.      In the record field list next to NOT, type 950 over the default field name.
 
7.      In the keyword box below, type 1.
 
8.      Click Search. This displays all unverified bibliographic  records. Review them to check for
completeness and misspellings.
 
9.      On the Edit menu, select Bibliographic, select Update Authority Control, and then click Verify
New.
 
NOTE: You can perform step 9 without first searching for the unverified bibliographic records. However, it is always a good idea
to review your bibliographic records before verifying them.
 
Step 3: Review Your Authority Records
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Authority records are constantly changing. Authors get married and change their names. New subjects are
added. Unless you subscribe to the Library of Congress database, you will have to update and maintain
your authority records on a regular basis.
 
If you subscribe to the Library of Congress database, Mandarin is developing a way to dynamically update
your authority records whenever a change is made to the database. Currently, in order to download the
updated records, you have to re- verify your records.
 
 
In M3, any changes you make to your authority records are automatically reflected in the linked bibliographic
  fields. For example, you notice a misspelling in one of your authority records and correct it. As soon as
you save that correction, all bibliographic  fields that are linked to that authority record are automatically
updated. No manual intervention is necessary.
 
Step 4: Review Your Skeletal Authority Records
You should periodically review your skeletal authority records to make sure they were created correctly. For
more information, see “Step 6: Check Your Skeletal Authority Records".
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Implementing Cross-References
 
Established headings are only a small part of Authority Control. While it is important to maintain accurate
and consistent headings in your bibliographic records, Authority Control consists of much more. It is also a
vital tool for patrons when searching your collection; it directs them to the correct titles if they search on an
incorrect or “unestablished” heading. This is done with a See reference in the OPAC.
 
Just as important, Authority Control can suggest alternate or related headings in which the patron may be
interested. For example, if patrons search for titles by Stephen King, they may also be interested in titles
written under Stephen King’s pen name, Richard Bachman. With Authority Control, they would be directed
to those titles with a See also reference.
 
Another advantage is that patrons can find all the titles and related titles in your collection with just one
search. This is because all your headings are consistent and all your bibliographic  records have been
linked to those headings.
 
The authority records contain the link from the bibliographic  field to the appropriate cross-reference.  The
authority records do not only contain established headings for a bibliographic field; they also contain fields
with the appropriate cross-reference for that specific bibliographic field.
 
Implementing “See” References
The See reference directs a patron from an unestablished heading to the established heading. For example,
a patron is searching for titles by the author Jean Plaidy. However, the patron searches for the titles using
Jean Plaidy’s legal name, Eleanor Hibbert. Jean Plaidy is the established heading for this author; Eleanor
Hibbert is the unestablished heading. The patron needs to be directed to the correct heading through the
See reference.
 
Your authority record for Jean Plaidy would consist of the entry Jean Plaidy in MARC field 100 – Personal
Name Heading. MARC field 100 is where the established heading is stored. In addition, this authority record
would have an another field for the See reference;  this field would have the entry Eleanor Hibbert.
 
Authority records have specific fields where the See reference is stored, based on whether the bibliographic 
field is a name, subject, or uniform title/series. Table 3 lists the See reference fields in an authority record.
 
 
TABLE 3



Implementing Cross-References

© 2014 Mandarin Library Automation, Inc. All rights reserved.
 

15 of 24

 
Using the Jean Plaidy example, your authority record would have the entry Jean Plaidy, 1906- in MARC field
100 – Personal Name Heading. The See reference Eleanor Hibbert, 1906- would be in MARC field 400 –
See From Tracing Personal Name. The basic authority record would appear as shown in Figure 2:
 
FIGURE  2

 
Implementing “See Also” References
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The See also reference directs a patron from an established heading to other related established headings.
If a patron is searching for titles by the author Jean Plaidy, a See also reference directs the patron to other
titles written by Jean Plaidy under the pen names of Victoria Holt and Philippa Carr.
 
By now, your authority record for Jean Plaidy consists of Jean Plaidy, 1906- in MARC field 100 (the
established heading), and Eleanor Hibbert, 1906- in MARC field 400 (the See reference). This authority
record also needs fields for the See also references to store the Victoria Holt and Philippa Carr entries.
 
Like See references,  See also references are stored in a specific field in the authority record, based on
whether the bibliographic  field is a name, subject, or uniform title/series. Table 4 lists the See also reference
fields in an authority record.
 
TABLE 4
See Also Reference Field Corresponding Bibliographic Field

Field 500 Personal Name Field 100 Personal Name (Main Entry)
 
Field 600 Personal Name (Subject Added
Entry)
 
Field 700 Personal Name (Added Entry)
 
Field 800 Personal Name (Series Added
Entry)

Field 510 Corporate Name Field 110 Corporate Name (Main Entry)
 
Field 610 Corporate Name (Subject Added
Entry)
 
Field 710 Corporate Name (Added Entry)
 
Field 810 Corporate Name (Series Added
Entry)

Field 511 Meeting Name Field 111 Meeting Name (Main Entry)
 
Field 611 Meeting Name (Subject Added
Entry)
 
Field 711 Meeting Name (Added Entry)
 
Field 811 Meeting Name (Series Added Entry)

Field 530 Uniform Title/Series Field 130 Uniform Title (Main Entry)
 
Field 240 Uniform Title
 
Field 440 Series Statement
 
Field 630 Uniform Title (Subject Added Entry)
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Field 730 Uniform Title (Added Entry)
 
Field 830 Uniform Title (Series Added Entry)

Field 550 Topical Term Field 650 Topical Term (Subject Added Entry)

Field 551 Geographic Term Field 651 Geographic Term (Subject Added
Entry)

 
 
In the Jean Plaidy example,  two additional fields would be added for the two See also references. The See
also references  Victoria Holt, 1906- and Philippa Carr, 1906- would be entered in MARC field 500 – See
Also From Tracing Personal Name. The basic authority record would appear as shown in Figure 3.
 
FIGURE  3
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Quick Editor
 
The Quick Editor is a feature that allows you to quickly create authority records without wading through all
the fields and subfields that make up an authority record. It is a simple window in which you can enter basic
information about the authority record in non-MARC format along with any See or See also reference.
 
If you subscribe to the Library of Congress database, you never need to create authority records; they are
automatically downloaded.  If you receive your authority records from a vendor, you may occasionally need
to create an authority record. The Quick Editor would be helpful in this case and any time you need to create
many new authority records.
 
The Quick Editor is not recommended if you want to protect the integrity of your authority records. Since
there are no guidelines or rules when using the Quick Editor, your authority records will be basic records
subject to the skills and judg- ment of the person creating the record. For this reason, there is a permissions
option in Group Editor for this feature so it can be disabled for a particular patron group.
 
To access the Quick Editor in the Cataloging module:
 
1.      On the File menu, select New, select Authority Record, and then click the type of authority record
you want to create. This displays the authority record template in MARC format.
 
2.      Click Quick. This displays the Quick Editor window (the Quick Editor window for a Personal Name
heading is shown in Figure 4).
 
FIGURE  4

 
Creating a quick authority record consists of two steps.
 
Step 1: Set  Up  the  Established Headings
The Quick Editor window contains the fields and subfields in non-MARC format that are essential for a basic
authority record. The upper pane contains informa- tion for the established heading, while the lower pane
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contains information for the See From and See Also From references. If after entering the basic information
you want to return to the MARC template to add additional information, click MARC.
 
Depending on the authority template you choose, different fields display in the Quick Editor window.
Although the first field is always required, the other fields are optional. The authority templates are:
 

•     Corporate Name – The Corporate Name and Subordinate Unit fields display (corresponding to
MARC field 110#a and b of an authority record).
 
•     Geographic Name – The Geographic Term, General Subdivision, Chronological Subdivision,
and Geographic Subdivision fields display (corresponding to MARC field 151#a, x, y, and z of an
authority record).
 
•     Meeting Name – The Meeting Name, Number of Part/Section/Meeting, Date of Meeting,
Location of Meeting, and Subordinate Unit fields display (cor- responding to MARC field 111#a, n, d,
c, and e of an authority record).
 
•     Personal  Name – The Personal Name, Words Associated With Name, Fuller Form of Name,
and Dates fields display (corresponding to MARC field 100#a, c, q, and d of an authority record).
 
•     Uniform Title/Series – The Uniform Title, Date of Work, Number of Part/ Section, Name of Part/
Section, Language of Work, Version, and Form Sub- heading fields display (corresponding to MARC
field 130#a, f, n, p, l, s, and k of an authority record).
 
•     Topical Term – The Topical Term, General Subdivision, Chronological Sub- division, and
Geographic Subdivision fields display (corresponding to MARC field 150#a, x, y, and z of an
authority record).

 
Step 2: Set  Up  the  Cross-References
Regardless of the authority template you choose, all cross-references are set up in the same manner. The
procedure is the same for See From References and See Also From References.
 

•     To add a cross-reference, click Add next to the desired box. This displays the same fields and
subfields as the established heading in non-MARC format. The first field is required but all other
fields are optional. You can add as many cross-references  as desired.
 
•     To delete a cross-reference, select the desired reference, and then click Delete.
 
•     To edit a cross-reference, select the desired reference,  and then click Edit.
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Additional Features
 
M3 offers additional Authority Control features that help you manage the Authority Control module in an
easy and efficient manner.
 

•     Flexibility in maintaining your authority control records – You can edit, delete, and purge
your authority records at any time. Any edits made to authority records are automatically reflected
in the associated biblio- graphic fields. Deleting and purging authority records does not affect
the associated bibliographic records in any way (except to unlink the authority record from the
bibliographic record).
 
•     Authority verification logs – Every time you perform a verification of your bibliographic
records, a verification log is generated. Among other things, this log lists the number of authority
records created. If you subscribe to the Library of Congress database, it lists the number of authority
records downloaded.  It also lists any bibliographic  subject field records that were not verified.
 
•     Automatic flipping  of unestablished headings – If a bibliographic field has an unestablished
heading, this heading will be flipped to the established heading during the verification process. For
example, one of your bibliographic records has the unestablished heading Steven King, 1947- in
MARC field 100 – Personal Name Heading. During verification,  this is flipped to the established
heading Stephen King, 1947-.
 
•     Easy  access to the authority  table when working with bibliographic records – If you are
editing or creating a new bibliographic record, you have easy access to your authority table. For
example, if you are adding a new subject (MARC field 650 – Topical Term) to a bibliographic record,
all your subject authority records automatically display. You can then scroll through the authority
records and choose the subject you want. No typing is required.
 
 
•     An Override Authority  feature – If you do not want the authority records to automatically
display when you are cataloging, you can disable this by selecting the Override Authority check box.
This allows you to type your entries in bibliographic  fields that are under Authority Control. However,
this option should be used carefully because:
 

•     You risk creating an incorrect authority record.
 
•     You will have to verify the bibliographic record when you are finished, since your typed
entry has to be added to the authority table. You will be reminded to verify the bibliographic
record when saving. Until the record is verified, it will not display the MARC field 950 –
Authority Control Flag.
 

•     Find and Replace – Find and Replace is fully functional on authority records. To protect the
integrity of bibliographic  fields under Authority Control, the Replace function is not functional on
these fields.
 
•     Import and export of authority  records – Authority records can be imported and exported
with the same ease as bibliographic  and patron records.
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•     Security for all Authority Control functions – The Cataloging Access window in Group Editor
includes permissions for all Authority Control functions in Cataloging. This includes adding, editing,
deleting, and purging authority records, as well as permissions for the Replace and the Unlink Biblio-
graphic functions.
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Glossary of Terms
 
Authority
Control

 A system that maintains consistency  in cataloging terms and
provides interconnecting links among names, subjects, and uniform
titles/series through the use of cross-references.

authority record  A record that contains the established heading and cross-references 
for a bibliographic field under Authority Control.

authorized
heading

 The correct term for a name, subject, and uniform title/series as
defined by the Library of Congress. Also known as the established
heading.

authority table  In M3, the table where all authority records are stored.
cross-
reference

 A link from an unestablished heading to an established heading,
or a link from an established heading to other related established
headings. In Authority Control, there are two types of cross-
references:  See and See also.

established
heading

 The correct term for a name, subject, and uniform title/series as
defined by the Library of Congress. Also known as the authorized
heading.

Library of
Congress
database

 A database maintained by the Library of Congress containing over
5 million authority records. This database is available with M3 for
automatic downloading of authority records.

MARC field 950  In M3, the Authority Control Flag field in a bibliographic record.
The presence of this field indicates that the bibliographic  record is
verified (that is, all its bibliographic fields under Authority Control are
linked to their associated authority records).

See  Also From
tracing

 The correct definition for a See also reference as displayed in M3.

See  also
reference

 A link from an established heading to other related established
headings. For example, Swine… See also Livestock. The See
also reference is stored in the 5xx field of the authority record. An
established heading can have an unlimited number of See also
references.

See  From
tracing

 The correct definition for a See reference as displayed in M3.

See  reference  A link from an unestablished heading to the established heading.
For example: Pigs… See Swine. The See reference is stored in the
4xx field of the authority record. An established heading can have an
unlimited number of See references.

skeletal
authority record

 In M3, the authority record that is created if an exact match is not
found between a bibliographic  field and an existing authority record.

subfield @  In M3, the subfield in a bibliographic  field that contains the ten digit
control number of the associated authority control record.

subject scheme  The type of subject record as defined by the second indicator of the
bibliographic field. Applicable to all the 6xx subject fields.

unauthorized
heading

 The incorrect term for a name, subject, and uniform titles/series as
defined by the Library of Congress. This type of heading would be a
See reference. Also known as the unestablished heading.
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unestablished
heading

 The incorrect term for a name, subject, and uniform titles/series as
defined by the Library of Congress. This type of heading would be a
See reference. Also known as the unauthorized heading.

verification  In M3, the process by which bibliographic  fields under Authority
Control are linked to the app
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Contacts & Credits
 

POSTAL ADDRESS
Mandarin Library Automation, Inc.
P.O. Box 272308
Boca Raton, FL 33427-2308
 
PHONES AND FAX
(800) 426-7477 Toll-free
(561) 995-4010 Local
(561) 995-4065 Fax
 
REGULAR OFFICE HOURS
M-F 8:30AM - 5:00PM EST
 
TECHNICAL SUPPORT HOURS
24x7x365 - 24 hours/day, 7 days/week
 
BY EMAIL
Sales & Marketing: automation@mlasolutions.com
Customer Service: automation@mlasolutions.com
Technical Support: support@mlasolutions.com
Webmaster: webmaster@mlasolutions.com
 

 

mailto:automation@mlasolutions.com
mailto:automation@mlasolutions.com
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